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Tutorial

Overview
This tutorial demonstrates how to use Roland Face Designer,
particularly its Interactive Sculpting tools, to create the side profile
of a person's face. Roland Face Designer is an extremely powerful
tool. It does the majority of the work required to create a pleasing
cameo-style model. By using its Face Wizard, the base shape of the
face is created along with a great deal of detail. However, the
generated model does require some editing. It is very difficult for a
computer to create a face, since human features vary so widely. Most
editing is done using its Interactive Sculpting tools. Knowing how
to use the Interactive Sculpting tools is as important as knowing
how to use the Face Wizard itself.
The creation process for a face relief has been broken down into
several steps. In this tutorial we will use a photographic image of a
lady's face, but you should be able to apply the steps within the
tutorial to almost any face. Please use the tutorial as a general guide;
your results do not have to exactly match those shown, as every
person sculpts in a different manner.
Before you begin using the Interactive Sculpting tools, it is
recommended that you print the image of the person you are
modelling. Study the image carefully before modelling it. Consider
that people have different facial features. This may require you to ask
yourself a few questions, including:

• Does the person have prominent cheekbones?
• How does their neck blend into their head?
• Do they have a strong jaw line?
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Each of the aforementioned thoughts, and many more, should be
considered. You should be able to study a photographic image and
identify both its strong and weak features. Being knowledgeable about
the Interactive Sculpting tools allows you to adjust the values in
this tutorial to suit whoever you might be modelling.

Roland Face Designer Tutorial
The steps that you will cover during the course of this tutorial are:

• Preparation.
• Importing the Photo Image.
• Creating a Vector Outline.
• Editing the Vector Outline.
• Identifying the Key Features.
• Sculpting the Relief.
• Saving the Model.
• Importing the Relief into Roland Medal Editor.

You shall work through each of these stages, and be guided through
the complete process of using the Face Wizard to create a relief from
an imported photographic image, sculpting the relief using the
Interactive Sculpting tools to improve its overall appearance,
saving the relief and then importing it into Roland Medal Editor.

Step 1 - Preparation
Before we can begin to create a model of a person's face, we must first
launch the Roland Face Designer software and its associated Face
Wizard.

1. Start the Roland Face Designer software. The default install
location is C:\Program Files\Roland Face Designer.

2. Click on the Face Wizard icon  on the Assistant's
Getting Started page to launch the Face Wizard. The
Step One settings of the Face Wizard are now displayed
on the Face Designer tab.
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Step 2 - Importing the Photo Image
Now that we have started the Face Wizard, we are ready to import
the image file containing the photo image from which we want to
create a relief.

1. Click on the Open Photo… icon  to display the
Select Image dialog box.

2. Click on the Look in list box and then select the Examples
folder on your Roland Face Designer installation CD.

3. Click to select the Girls_head.tif image file. Its name is
displayed in the File name box.

4. Click on the Open button to display the photo image in the
2D View window. The Step Two settings of the Face
Wizard are displayed on the Face Designer tab.

Step 3 - Creating a Vector Outline
Now that we have imported the photo image into the Face Wizard,
we are ready to create a vector outline following the profile of the
neck, face and head.

1. Click on the Draw Smooth Polyline option to select it.
This option allows us to create a polyline using bezier spans
rather than linear spans, thus producing a smoother shape.
This option is deselected by default.

2. Click on the Create Polyline Tool button  so that you
are ready to begin sketching a polyline following the profile
of the neck, face and head shown in the photo image. A
white rectangle appears over the button area to indicate that
it is active.

3. Move the  cursor over the photo image shown in the 2D
View window, and then draw a polyline around the outline
of the neck, face and head by clicking on the following
areas:

• First, create the start point in the polyline at the
bottom-front portion of the neck.

• Next, start clicking upwards at regular intervals
along the profile of the neck towards the chin.
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• Next, continue clicking upwards at regular intervals
along the profile of the facial features towards the
lips and nose as shown below:

• Finally, continue clicking at regular intervals around
the profile of the eyes, forehead and hair until you
reach the bottom of the hairline where it touches the
neck.

4. Click on the Close Vector With A Line button  to
join the start and end points in the polyline with a linear
span. It is important that your polyline is closed before
proceeding to the next step.
In the following image, the vector boundary has been
enhanced to highlight the area of the photo image to trace
around:
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Step 4 - Editing the Vector Outline
It is extremely important that the closed vector is positioned just inside
of the person's face and hair, and not on the background shown in the
photo image. If the vector remains outside of the face, flat areas are
produced when its relief is generated. The easiest way to avoid this
problem is to use the Node Editing tools available in the Roland Face
Designer to shift the nodes that make up the vector inwards by a pixel
or two, immediately after the vector has been drawn.
You can also edit the nodes within the vector, as well as their
associated control points, to adjust its overall shape using the available
Node Editing shortcuts.
You can use the I key on your keyboard to insert a new node, the D
key to delete a selected node, or the S key to either smooth or
unsmooth a selected node.

1. Make sure that the vector is selected by clicking on it. It is
shown in magenta and is surrounded by a bounding box.

2. Press the N key on your keyboard to enter Node Editing
mode. You can now see the nodes, control points and spans
that make up the vector.

3. Edit the vector outline so that it fits perfectly around the
outline of the neck, face and head in the photo image,
making sure it is approximately a pixel width into the face,
away from the background.

4. Click on the Next button to display the Step Three
settings of the Face Wizard.
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Step 5 - Identifying the Key Features
Now we are ready to identify two key features in our photo image
relative to our vector outline: the centre-front of the eyebrow and the
nape of the neck. The Face Wizard cannot calculate the relief
without first identifying these features.

1. Click on the centre-front area of the eyebrow in the photo
image. A red square appears indicating its position.
If you make a mistake when identifying this position, click
on the Remove Points button and repeat the step.

2. Click on the position where the shirt-collar meets the
neckline in the photo image to mark the nape of the neck. A
red square appears indicating its position.

If you make a mistake when identifying this position, click
on the Remove Points button and repeat the step.

3. Click on the Next button to display the Step Four settings
of the Face Wizard and begin the relief calculation
process.
A progress bar appears below the 2D View window
showing the progress that the Roland Face Designer is
making in calculating the relief from the imported photo
image, using the vector outline you have drawn and the key
features you have identified.
Once the Roland Face Designer has finished calculating the
relief, the Interactive Sculpting page is displayed on the
Assistant tab, and the relief is displayed in the 3D View
window with the original photographic image imposed onto
its surface.
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Step 6 - Sculpting the Relief
Now that the Face Wizard has generated a relief from our photo
image, we are ready to improve its overall appearance using the
Interactive Sculpting tools that are displayed.
The relief shown in the 3D View window appears with a greyscale
image of the face imposed over it by default. Whilst this makes it easy
to identify facial features clearly, leaving the image imposed over the
relief surface can make your sculpting results very deceptive. The
photo image often obscures how each of the sculpting tools affect the
relief. You may prefer to leave the photo image imposed at intervals in
order to identify facial features clearly, and how they should or should
not be modified. However you prefer to view the face relief at any
given time is entirely your choice.

Smoothing the Skin
Our first objective is to remove the 'orange-peel' effect often visible on
the areas of the relief that identify the skin of the face. In order to do
so, we can use the Smooth tool from the set of Interactive
Sculpting tools. All of the settings for this particular tool are
maximised to allow us to quickly clean the blemishes from the relief
surface. You should avoid sculpting near any of the facial features, as
this will damage the detail currently preserved in the relief. You
should only smooth the areas of the relief identifying the skin of the
face where the sculpting cursor easily fits. Only after the blemishes
have been removed can we begin to work on the facial features.

1. In the Shading Colour area of the page, click to deselect
the Use colours from 2D View option. This hides the
greyscale image of the face that is imposed onto the surface
of the relief.
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Before… After…

2. Make sure that the Smooth tool  is selected by
pressing the number 1 key on your keyboard. This tool is
selected by default the first time that you use the
Interactive Sculpting tools.

3. Make sure that the Diameter of the tool is set to 100, and
both the Strength and Smoothness are set to 100%. If
this is the first time you are using the Sculpting tools, these
are the default values for these settings. You can click on
the slider and drag it to the far right if the settings are set
otherwise.

4. Move the cursor over the area of the relief identifying the
skin of the face, and then click and drag to begin smoothing
over it. Be careful to avoid the areas of the relief identifying
the hair, eye, nose, lips and ear.
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Area To Sculpt… After Sculpting…

5. With the Smooth tool  still selected, adjust the
Diameter of the tool so that it is set to 50.

6. Make sure that both the Strength and Smoothness of
the tool remain set to 100%.

7. Move the cursor over the area of the relief identifying the
skin of the face, and then click and drag to begin smoothing
the areas that the previous tool settings were not able to
reach. Be careful to avoid the areas of the relief identifying
the hair, eye, nose, lips and ear. You no longer need to avoid
the eyebrow area using these particular tool settings, as we
shall restore the detail in the eyebrow at a later stage in this
tutorial.
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Areas To Sculpt… After Sculpting…

8. With the Smooth tool  still selected, adjust the
Strength of the tool so that it is set to 20%.

9. Make sure that the Diameter of the tool remains at 50, and
the Smoothness remains at 50%.

10. Move the cursor over the area of the relief identifying the
nose, and then click and drag to begin smoothing it. Be
careful to avoid the area of the relief identifying the nostril.

Areas To Sculpt… After Sculpting…
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11. Move the cursor over the area of the relief identifying the
ear, and then carefully click and drag over its flat or
recessed areas only. Since the ear in the photo image used in
this tutorial is concealed by the hair, we can proceed to the
next step.

12. Move the cursor over the areas of the relief identifying the
nostril, lips, and eye in turn, each time clicking and
dragging to make no more than two individual passes over
each facial feature. Be careful not to exceed this number of
smoothing passes, as you might lose some detail in these
facial features.

Areas To Sculpt… After Sculpting…

13. With the Smooth tool  still selected, adjust the
Diameter of the tool so that it is set to 20. You can click on
the slider and drag it slightly to the left to achieve this.

14. Adjust the Smoothness of the tool so that it is set to
100%. You can click on the slider and drag it to the far right
if the setting is shown otherwise.

15. Make sure that the Strength of the tool remains at 20%.
16. Move the cursor over any areas of the relief identifying

either the skin of the face or the facial features that you may
have missed in turn, each time clicking and dragging to
smooth over these features.

17. Move the cursor over the area of the relief identifying the
ear, and then carefully click and drag over its flat or



12  •  Tutorial Roland Face Designer

recessed areas only. Since the ear in the photo image used in
this tutorial is concealed by the hair, we can proceed to the
next step.

18. Click to select the Use colours from 2D view option.
The greyscale image of the photo image is imposed onto the
surface of the face relief.

19. With the Smooth tool  still selected and using the
existing settings, move the cursor over the areas of the relief
identifying the skin of the face that surrounds the lips, eye,
nose and hair in turn, each time clicking and dragging to
smooth around these features.

Areas To Sculpt… After Sculpting…

20. If you have lost any important detail on or around any
specific facial features, select the Erase tool by pressing
the number 5 key on your keyboard. Using the default or
your own preferred settings for the tool, click and drag the
cursor over the areas in question to remove any smoothing
you have already applied and to restore their original detail.

21. Click on the Apply button to save the changes made to the
relief thus far. Once the Apply button has been used, you
cannot erase any prior changes made to the relief.

Sculpting the Eyebrow
Now that we have removed all blemishes from the surface of the face
relief, we are ready to begin sculpting the facial features to emphasise
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their detail. We shall begin by creating an eyebrow using the Deposit
tool.

1. Select the Deposit tool  by pressing the number 3 key
on your keyboard. Its settings are displayed on the page.

2. Adjust the Diameter of the tool so that it is set to 5.
3. Adjust the Strength of the tool so that it is set to 10%.
4. Make sure that the Smoothness of the tool is set to 100%.

If this is the first time you are using the Sculpting tools, this
is the default value for this setting. You can click on the
slider and drag it to the far right if the setting is set
otherwise.

5. Click on the Zoom button  in the 3D View toolbar, and
then click and drag to create a bounding box around the area
of the relief that includes the eyebrow, eye and nose.

6. Release the mouse button to adjust the 3D View window so
that it is focused on these facial features only.

7. Click and drag the cursor in a scribble motion over the area
of the relief identifying the eyebrow. You can use the image
imposed onto the relief surface for guidance.

8. Click to deselect the Use colours from 2D view option.
The greyscale image of the photo image is no longer
imposed onto the surface of the face relief.

Area To Sculpt… After Sculpting…

9. With the Deposit tool  still selected and using the
existing tool settings, move the cursor over the area of the
relief identifying the eyebrow and then click and drag to add
any detail that you feel is missing from the feature.
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10. Click on the View Down Z button  in the 3D View
toolbar to view the face relief down the Z axis.

11. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Sculpting the Cheekbone
Now that we have sculpted the eyebrow, we are ready to move onto
adding a defined cheekbone area to the face relief using the Smudge
tool.

1. Select the Smudge tool by pressing the number 2 key
on your keyboard. Its settings are displayed on the page.

2. Adjust the Diameter of the tool so that it is set to 30.
3. Adjust the Strength of the tool so that it is set to 10%.
4. Make sure that the Smoothness of the tool is set to 100%.

If this is the first time you are using the Sculpting tools, this
is the default value for this setting. You can click on the
slider and drag it to the far right if the setting is set
otherwise.

5. Move the cursor over the area of the face relief beside the
hairline whilst being careful not to touch it, and then click
and drag slowly towards the nose area to smudge the
existing stark cheekbone shape forwards. When the edge of
the cursor reaches the nose, release the mouse button.

6. Repeat the previous step until you have created a realistic
cheekbone shape in the face relief. It is important to
continue smudging the relief in the same direction,
otherwise you will produce unwanted results.
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Area To Sculpt… After Sculpting…

You may have to repeat this step several times, depending
on just how pronounced the person's cheekbone is in your
photo image. Approximately two to eight passes are usually
required to produce a successful cheekbone shape. The
female in our photo image has fairly prominent cheekbones,
so it will take us approximately five passes to achieve the
desired result.

7. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Sculpting the Chin
Now that we have sculpted the cheekbone, we are ready to move onto
adding a chin area to the face relief using the Smudge tool.

1. With the Smudge tool  still selected, adjust the
Diameter of the tool so that it is set to 100.

2. Make sure that the Strength of the tool remains at 10%
and its Smoothness at 100%.

3. Move the cursor over the area of the face relief near the
earlobe, and then click and drag gradually along the jawline
towards the tip of the chin. When the edge of the cursor
reachs the tip of the chin, release the mouse button.

4. Repeat the previous step until you have created a realistic
chin shape in the face relief. It is important to continue
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smudging the relief in the same direction, otherwise you
will produce unwanted results.

Area To Sculpt… After Sculpting…

You may have to repeat this step several times, depending
on just how pronounced the person's chin is in your photo
image. Approximately five to twelve passes are usually
required to produce a successful chin shape.

5. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Sculpting the Jaw
Now that we have sculpted the chin, we are ready to move onto adding
a jaw area to the face relief using the Smudge tool.

1. With the Smudge tool  still selected, make sure that
the Diameter of the tool remains at 100, its Strength at
10% and its Smoothness at 100%.

2. Move the cursor over the area of the face relief below the
jawline beneath the chin, and then click and drag gradually
along the jawline towards the back of the neck area. When
the edge of the cursor reachs the back of the neck, release
the mouse button.

3. Repeat the previous step until you have created a realistic
jaw shape in the face relief. It is important to continue
smudging the relief in the same direction, otherwise you
will produce unwanted results.
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Area To Sculpt… After Sculpting…

You may have to repeat this step several times, depending
on just how pronounced the person's jaw is in your photo
image. Approximately two to five passes are usually
required to produce a successful jaw shape.

4. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Sculpting the Neck
Now that we have sculpted the jaw, we are ready to move onto
detailing the neck area in the face relief using the Smudge tool.

1. With the Smudge tool  still selected, make sure that
the Diameter of the tool remains at 100, its Strength at
10% and its Smoothness at 100%.

2. Move the cursor over the area of the face relief below the
jawline beneath the chin, and then click and drag gradually
along the jawline towards the back of the neck area where it
meets the hairline. When the edge of the cursor reaches the
back of the neck where it meets the hairline, release the
mouse button.

3. Move the cursor over the area of the face relief below the
jawline, and then click and drag gradually from the jawline
downwards towards the base of the neck area. When the
edge of the cursor reaches just over the base of the neck,
release the mouse button.
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Areas To Sculpt… After Sculpting…

4. Repeat the previous two steps until you have created a
realistic neck shape in the face relief.

5. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Smoothing the Smudged Areas
Now that we have sculpted the cheekbone, chin, jaw and neck areas in
the face relief, we are ready to smooth over them to remove any
blemishes.

1. Select the Smooth tool  by pressing the number 1 key
on your keyboard. Its settings are displayed on the page.
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2. Adjust the Diameter of the tool so that it is set to 100.
3. Adjust the Strength of the tool so that it is set to 10%.
4. Make sure that the Strength of the tool remains at 100%.

You can click on the slider and drag it to the far right if the
setting is set otherwise.

5. Move the cursor over the areas of the relief identifying the
cheekbone, chin, jaw and neck in turn, each time clicking
and dragging to make no more than two individual passes
over each of the facial features. Be careful not to exceed this
number of smoothing passes, as you might lose some detail
in these facial features.

Areas To Sculpt… After Sculpting…

6. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Smoothing the Ear
Typically, you would now smooth over the ear but since the ear is
concealed by hair detail in our photo image we can ignore this step.

Smoothing the Hair
Now that we have smoothed over the cheekbone, chin, jaw and neck
areas in the face relief, we are ready to smooth over the hair area. This
has the affect of slightly reducing the definition currently visible in the
hair area, making it significantly easier to machine the finished relief.
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1. With the Smooth tool  still selected, make sure that the
Diameter of the tool remains set at 100, its Strength at
10% and its Smoothness at 100%.

2. Move the cursor over the hair area of the relief and then
click and drag to gradually cover its entire area. Make no
more than a single pass over the hair area otherwise you risk
losing its definition altogether.

Areas To Sculpt… After Sculpting…

3. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

Restoring Missing Hair Definition
You may find that if the hair of the person shown in the photo image
is naturally dark, or if a light source has reflected off of surrounding
areas, significant hair detail can be lost in the relief. In order to restore
sparse areas of hair in the relief, you can use the Deposit tool. It is
recommended that you set the Diameter of the tool somewhere
between 5 and 10, depending on the thickness of the hair, and its
Strength to 50%. Also, make sure that the Merge option is selected
in the Relief Combine Mode area, as this method allows you to
avoid adding hair with extreme heights. To sculpt new areas of hair,
click and drag in the direction of the existing hair in a scribble motion
equal to the distance of the existing hair length.
In this tutorial, the female shown in our photo image has light hair and
none of its detail is missing. However, there is an area in the relief
where we can notice that the hair blends into a facial feature. The area
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where the hair conceals the ear could be made more distinctive. To
achieve this effect, we only need to extend the existing hair using the
Smudge tool.

1. Select the Smudge tool  by pressing the number 2 key
on your keyboard. Its settings are displayed on the page.

2. Adjust the Diameter of the tool so that it is set to 8.
3. Make sure that the Strength of the tool remains at 10%

and its Smoothness at 100%.
4. Move the cursor over the area of the hair where it's ends

would meet the position where the face meets the ear, and
then click and drag towards the face to extend the strands of
hair that conceal the ear.

Area To Sculpt… After Sculpting…

5. When you are happy with the result, click on the Apply
button to save the changes made to the relief thus far.

6. Click on the Finish button to return to the Assistant's
Home page.
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Step 7 - Saving the Model
Now that we have finished sculpting the relief, we are ready to save
the relief along with its associated model file.

1. Click on the Save button  in the File area to display the
Save As dialog box.

2. Click on the Save in list box, and then on the location on
your computer in which you want to save the Roland Face
Designer model and its associated relief.

3. Type Lady_Face in the File name box.
4. Click on the Save button to close the dialog box and save

the Roland Face Designer model file (*.rfd) containing the
finished face relief.

Step 8 - Importing the Relief into Roland
Medal Editor
Now that we have saved the relief and its associated model file, we are
now ready to use the finished relief in Roland Medal Editor.

1. Click on the Roland Medal Editor button  in the File
area of the Assistant's Home page to display the Save As
dialog box.

2. Click on the Save in list box, and then browse to the
location on your computer in which you want to save the
relief as a bitmap file.

3. Type a name for the relief in the File name box.
4. Click on the Save button to save the relief as a bitmap file

(*.bmp), close the dialog box and then open the bitmap in
Roland Medal Editor.

For information on using Roland Medal Editor, please refer to its own
Installation & Operation Guide.
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Using Roland Face
Designer

Roland Face Designer Layout
Although you will encounter the powerful Face Wizard first and
foremost, this tool only begins to demonstrate the capabilities of
Roland Face Designer.
The Assistant window in Roland Face Designer is just as important
as the Face Wizard. The Assistant's Home page displays a
collection of tools to help you develop the relief generated by the
Face Wizard tool, so that it is ready to be exported to Roland Medal
Editor. The layout of the screen is designed to allow you to achieve
effective and efficient results.
The screen layout is divided into four regions:
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These regions are as follows:
1. Main menu bar – You can click on a menu item to display

a drop-down menu containing a range of sub-menus and
commands relating to features in Roland Face Designer. If
an item in a menu is greyed-out, then it does not apply to the
active view in the design window area.

2. Assistant – On starting Roland Face Designer, the
Assistant's Getting Started page is displayed. This page
is divided into two areas. The Face Wizard area allows
you to start the Face Wizard tool and begin creating a
three-dimensional relief from a photographic image file.
The Open Existing Model area allows you to open any
Roland Face Designer model files (*.rfd) you already have,
listing the last four models on which you have been
working.
Once a photographic image has been imported into the
Face Wizard tool, the Assistant's Home page is
displayed. This page contains buttons for almost all of the
tools available in Roland Face Designer. For almost every
button you click on, a new page of settings is displayed in
its place. These buttons are divided into three areas:

• File – You can use these buttons to manage your
Roland Face Designer model files, correct a mistake
and repeat an action.
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• Vector Editing – You can use these buttons to
create vectors in the form of freeform shapes, circles
and text, as well as modify their structure and
position.

• Relief Editing – You can use these buttons to
sculpt the relief, create an angled plane and combine
three-dimensional text.

3. Design Windows – This is the central area of the screen.
Roland Face Designer uses two types of view. The 2D View
window displays the vector artwork drawn in your model,
and a greyscale of the two-dimensional photographic image
that you import into the Face Wizard tool. The 3D View
window displays a three-dimensional relief calculated from
the photographic image using the Face Wizard tool, as
well as any other three-dimensional shapes that you might
combine with the relief.

4. Face Designer – This tab contains the Face Wizard
tool. You can use this page to start the Face Wizard, but
you should be aware that starting the Face Wizard and
importing a new photographic image will mean that the
model that is currently open in Roland Face Designer will
be closed.

3D View Options
You can decide whether Roland Face Designer itself or a graphics
accelerator card using a set of fully OpenGL compliant drivers is used
to render the relief shown in the 3D View window.
Your choice should reflect the hardware installed in the computer on
which you have installed Roland Face Designer.
To adjust the 3D View options used in Roland Face Designer:

1. From the Main menu bar, click on the Window > 3D View
Options option to display the 3D View Options page.

2. Select either of the Open GL Drawing Mode options to
decide the method of shading that you want Roland Face
Designer to use when rendering your reliefs:

• Software Shading – Select this option if you want
Roland Face Designer to shade the relief using its
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own algorithms, independent of the graphic card that
you have installed in your computer.
If you have a fast processor installed alongside a
relatively poor graphics card, which is commonplace
on high-end notebook computers, you should select
this option.
If you select this option, Roland Face Designer re-
renders the relief every time its viewpoint is adjusted
or if the relief itself is modified in any way.

• Complete OpenGL – Select this option if you
want Roland Face Designer to shade the relief using
small triangles.
This option should only be selected if you have a fast
processor, a graphics accelerator card and a set of
fully compliant OpenGL drivers installed. For
example, NVIDIA's GeForce 2 Ultra, GeForce 3
Graphics Processing Unit (GPU) and above.

Warning: Many graphics accelerator cards have a limited subset of
OpenGL used only to meet the system requirements of selected
computer games. Please check with the manufacturer of your graphics
card to confirm that it is fully OpenGL compliant before selecting this
option.

3. Click on the Apply button to confirm your 3D View
settings.

4. Click on the Close button to return to the Assistant's
Home page.

5. Exit and then relaunch Roland Face Designer for your 3D
View settings to take effect. For details, see "Shutting Down
Roland Face Designer" on page 42 and "Getting Started" on
page 33.

Choosing the Window View
When you import a photographic image into the Face Wizard, both a
2D View and a 3D View design window are displayed. You can use
the 2D View window to create the vector artwork you will use to both
produce and develop a three-dimensional relief within Roland Face
Designer. This relief is shown in the 3D View window.



Roland Face Designer Using Roland Face Designer  •  27

To select between the 2D View and 3D View windows:
1. From the Main menu bar, click on the Window menu

followed by the option for which window you want to
display:

• 2D View – Click on this option to display the 2D
View window. This is the window that contains the
photo image imported into the Face Wizard, and all
vector artwork associated with creating and
developing the relief.

Note: You can also display the 2D View window by pressing the F2
key on your keyboard whenever the 3D View window is displayed.

• 3D View – Click on this option to display the 3D
View window. This is the window that contains the
relief itself.

Note: You can also display the 3D View window by pressing the F3
key on your keyboard whenever the 2D View window is displayed.

2D View Manipulation
You can change the view of the photographic image and vector
artwork shown in the 2D View window using the tools directly above
the window.

 3D View
Click on the 3D View button  to display the 3D View window.

Note: You can also display the 3D View window by pressing the F3
key on your keyboard whenever the 2D View window is displayed.

 Zoom In Tool
You can use the Zoom In Tool button  in two ways. You can:

• Enlarge the area directly beneath the  cursor by 50%; or
• Zoom in on a defined area of the model.
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To enlarge an area directly beneath the  cursor by 50%:

1. Click on the Zoom In Tool button , move the
magnifying cursor  over the area of the model that you
want to zoom in on, and then click.

Note: You can also magnify the area directly beneath the cursor by
50% if you hold down the Ctrl key on your keyboard and then right-
click.

To zoom in on an a defined area of the model:

1. Click on the Zoom In Tool button , and then move the
magnifying cursor  over the area of the model that you
want to zoom in on.

2. Click and drag to create a bounding box around the area of
the model in which you are interested.

3. Release the left mouse button to view the area defined by
the bounding box you have drawn.

 Zoom Out Tool
Each click on the Zoom Out Tool button  reduces the size of the
image by 50%.

Note: You can also reduce the area directly beneath the cursor by
50% if you hold down the Shift key on your keyboard and then right-
click your mouse.

 Zoom Previous
Click on the Zoom Previous button  to restore the previous zoom
setting.

 Window Fit
Click on the Window Fit button  to adjust the zooming so that the
whole model area is shown.

 Zoom Object(s)
Click on the Zoom Object(s) button  to focus in on the vector(s)
that are currently selected in the model area.
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 Zoom 1:1
Click on the Zoom 1:1 button  to return to a zoom aspect ratio of
1:1.

3D View Manipulation
You can change the view of the relief shown in the 3D View window
using the tools directly above the window.

 2D View
Click on the 2D View button  to display the 2D View window.

Note: You can also display the 2D View window by pressing the F2
key on your keyboard whenever the 3D View window is displayed.

 Twiddle Tool
The Twiddle Tool button  allows you to rotate the view of the
relief around a central point, adjust the viewpoint (pan) and zoom in or
out from the current viewpoint.
To rotate the view of the relief:

• First, click on the Twiddle Tool button .
• Move the cursor over the relief, click and hold down the left

mouse button, and then drag the relief to the required
viewing angle.

To pan the model:

• First, click on the Twiddle Tool button .
• Move the cursor over the relief, click and hold down both

mouse buttons, and then drag the relief to the required
viewing position.

To zoom in on the relief:

• First, click on the Twiddle Tool button .
• Move the mouse cursor over the relief, click and hold down

the right mouse button, and then drag upwards.
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To zoom out from the relief:

• First, click on the Twiddle Tool button .
• Move the cursor over the relief, click and hold down the

right mouse button, and then drag downwards.

 Pan View
The Pan View button  allows you to adjust the viewing position of
the model:

1. Click on the Pan View button .
2. Move the cursor over the relief, then click and drag the

relief into the required viewing position.

Note: You can also use the Twiddle Tool to adjust the viewpoint of
the relief. For details, see "  Twiddle Tool" on page 29.

 Zoom
You can use the Zoom button  to zoom in on a specific area of the
relief:

1. Click on the Zoom button , then move the magnifying
 cursor over the area of the relief that you want to zoom

in on.
2. Click and drag the mouse to create a bounding box around

the area of the relief that interests you.
3. Release the mouse button to zoom in on the area of the

relief defined by the bounding box.

Note: You can also use the Twiddle Tool to adjust the viewpoint of
the relief. For details, see "  Twiddle Tool" on page 29.

 Zoom Out
Click on the Zoom Out button  to reduce the size of the image by
50%.
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 Previous View
Click on the Previous View button  to restore the previous zoom
setting used.

 Scale To Fit
The Scale To Fit button  adjusts the view so that the whole relief
is shown.

 Isometric View
The Isometric View button  displays the relief in the standard
isometric view. The viewing angle is identified by the XYZ
representation drawn on the button.

 View Along X
The View Along X button  displays the relief as seen along the X-
axis.

 View Along Y
The View Along Y button  displays the relief as seen along the Y-
axis.

 View Down Z
The View Down Z button  displays the relief as seen down the Z-
axis.
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Working with Models

Getting Started
When you start Roland Face Designer, the Assistant's Getting
Started page is displayed. This page allows you to:

• Create a new model – A new Roland Face Designer
model is created whenever the Face Wizard tool is
launched and a photographic image is subsequently
imported. For details, see "Creating a Model" on page 33.

• Open an existing model – You can open Roland Face
Designer model files that you have previously saved. For
details, see "Opening an Existing Model" on page 34.

Creating a Model
A new Roland Face Designer model file is created each time you start
the Face Wizard tool from the Assistant's Getting Started page
and then import a new photographic image into the Face Wizard
tool.
The Face Wizard allows you to create a relief from a photographic
image containing a side-profile of a person's head and neck saved as a
Bitmap (*.bmp), TIFF (*.tif), GIF (*.gif) or JPEG (*.jpg) file. This
process is almost entirely automated.
To produce a detailed relief, your image should ideally be captured by
a digital source using a resolution of at least 1024 x 768 pixels. Colour
photographic images can be imported, but they will appear as black
and white in the Face Wizard.
To create a model:

1. Click on the Face Wizard icon  on the Assistant's
Getting Started page to launch the Face Wizard.
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The Step One settings of the Face Wizard are displayed
on the Face Designer tab.

2. Click on the Open Photo… icon  to display the
Select Image dialog box.

3. Click on the Look in list box and then browse to the
location on your computer where the photographic image
from which you want to create a face relief is stored.

Note: You can import photographic images saved as Bitmap
(*.bmp), TIFF (*.tif), GIF (*.gif) and JPEG (*.jpg) files only.

4. Once you have found the image that you want to use, click
to select the file. Its name appears in the File name box.

5. Click on the Open button to import the photographic image
and display a greyscale of its content in the 2D View
window.
The Step Two settings of the Face Wizard are displayed
on the Face Designer tab. A Roland Face Designer model
is now created, although it is not yet named.

For details on naming the model, see "Saving a Model" on page 35.
For details on continuing to use the Face Wizard, see the "Tutorial"
chapter.

Opening an Existing Model
To open a model that you have previously saved:

1. Click on the Open Existing Model icon  on the
Assistant's Getting Started page to display the Open
dialog box.

Note: You can also display the Open dialog box by pressing the Ctrl
+ O keys on your keyboard.

2. Click on the Look in list box, and then browse to the
location on your computer where the model you want to
open is stored. Roland Face Designer model files are
identified by the .rfd file extension.

3. Once you have found the model that you want to open, click
to select the file. Its name appears in the File name box.
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4. Click on the Open button to close the dialog box and open
the model.

Opening Recent Models
If you want to open a model that you were working on recently:

1. From the Assistant's Getting Started page, click on the
 icon beside the name given to the relevant Roland Face

Designer model file.

Saving a Model
You can save a Roland Face Designer model along with its associated
relief.
To save the model that you are working on:

1. Click on the Save button  in the File area of the
Assistant's Home page to display the Save As dialog
box.

Note: You can also display the Save As dialog box by pressing the
Ctrl + S keys on your keyboard, or by clicking on the File > Save
As option from the Main menu bar.

2. Click on the Save in list box, and then browse to the
location on your computer in which you want to save the
model.

3. Type a name for the model in the File name box.
4. Click on the Save button to close the dialog box and save

the model as a Roland Face Designer file (*.rfd).
To save the changes you have made to a model since it was last saved:

1. Click on the Save button  in the File area of the
Assistant's Home page.

Note: You can also save the model if you click on the File > Save
option from the Main menu bar.
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Saving a Relief as a Bitmap
You can save a Roland Face Designer relief as a bitmap file (*.bmp).
This bitmap file can then be used in the Roland Medal Editor. For
further details, see "Loading Image Data" in the Roland Medal Editor
Installation & Operation Guide.

1. Click on the Save Relief button  in the File area of the
Assistant's Home page to display the Save As dialog
box.

2. Click on the Save in list box, and then browse to the
location on your computer in which you want to save the
relief.

3. Type a name for the relief in the File name box.
4. Click on the Save button to close the dialog box and save

the relief as a bitmap file.

Correcting an Action
There are two buttons in the File area of the Assistant's Home page
that you can use to correct your mistakes when working on a model in
the Roland Face Designer.
To cancel your last action:

• Click on the Undo button  in the File area of the
Assistant's Home page.

Note: You can also cancel your last action by clicking on the Edit >
Undo… option in the Main menu bar, or by pressing the Ctrl + Z
keys on your keyboard.

To repeat the last action made prior to clicking on the Undo button:

• Click on the Redo button  in the File area of the
Assistant's Home page.

Note: You can repeat the last action that you have undone by clicking
on the Edit > Redo option in the Main menu bar, or by pressing the
Ctrl + Y keys on your keyboard.
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Mirroring a Model
You can mirror a model either vertically or horizontally. This allows
you to change the direction in which the person shown within the
photographic image imported into the Face Wizard tool is facing
prior to calculating the relief, or the actual face relief itself after the
calculation process is complete.
To mirror a model horizontally:

• From the Main menu bar, click on the Model > Mirror >
Horizontal option.

To mirror a model vertically:
• From the Main menu bar, click on the Model > Mirror >

Vertical option.

Adding a Border to a Model
By default, the size of the model area in Roland Face Designer is
equal to the dimensions of the photographic image that you import
into the Face Wizard tool. However, you can increase the size of the
model area by adding a border. The border appears in yellow, the
same colour used in the background of the model area.
To add a border to the model area:

1. From the Main menu bar, click on the Model > Add
Border option to display the Add Border dialog box.

2. Select the type of border that you want to apply to the model
area:

• If you want to apply a border around all four edges
of the model area, click to select the Symmetrical
option. This option is selected by default.

• If you want to apply a border along the top-edge of
the model area only, click to select the Top option.

• If you want to apply a border along the bottom-edge
of the model area only, click to select the Bottom
option.

• If you want to apply a border along the left-edge of
the model area only, click to select the Left option.
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• If you want to apply a border along the right-edge of
the model area only, click to select the Right option.

3. Define the depth of the border in the box beside the border
option that you have selected in the previous step.

4. Click on the OK button to close the dialog box and apply
the border to the model area. You can see that the overall
size of the model area has increased in the 2D View
window, as per your chosen border settings.

Rotating a Model
You can rotate a model in 90 degree increments in either a clockwise
or anti-clockwise direction.
To rotate a model clockwise:

• From the Main menu bar, click on the Model > Rotate 90
Degrees > Clockwise option.

To rotate a model anti-clockwise:
• From the Main menu bar, click on the Model > Rotate 90

Degrees > AntiClockwise option.

Closing a Model
You can close the model that you are currently working on.
To close a model:

1. From the Main menu bar, click on the File > Close option.
If you click on the Close option before saving any changes to the
model, a message box appears warning you that the model has
changed and gives you the option to save or disregard the model.
If you want to save the model:

• Click on the Yes button to open the Save As… dialog
box. For details on using this dialog box, see "Saving a
Model" on page 35.

If you do not want to save the model:
• Click on the No button to close the model without saving

your changes, and then return to the Assistant's Getting
Started page.



Roland Face Designer Working with Models  •  39

Note: You can click on the Cancel button to close the message box
and remain working in Roland Face Designer.

Printing a View Window
You can print either the content of the 2D View or 3D View window,
depending on whichever is visible at the time.
To print a view:

1. Make sure that the window that you want to print is visible
and its content is set, as you want it to appear in the printed
image. For details, see "2D View Manipulation" on page 27
and "3D View Manipulation" on page 29.

2. From the Main menu bar, click on the File > Print…
option to display the Print Setup dialog box.

3. Make sure that your printer settings are correct. For details,
see "Print Setup" on page 41.

4. In the Options area, click on the print option that you want
to use:

Note: If you are printing the 3D View window, the print options are
greyed-out. In this instance, Roland Face Designer prints to fit the 3D
View window in its current orientation.

• Click to select the Print model to scale option if
you want to print the model according to its
dimensions.

• Click to select the Stretch to fit page option if you
want to print the model according to the dimensions
of the paper onto which you are printing.

• Click to select the Print current screen view
option if you want to print the model as it currently
appears in the 2D View window.

5. Click on the OK button to close the Print Setup dialog
box and print the active view.
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Print Preview
You can view the content of the active view as it would appear when
printed. This is referred to as the print preview.
To create a print preview:

1. Make sure that the window that you want to print is visible
and its content is set, as you want it to appear in the printed
image. For details, see "2D View Manipulation" on page 27
and "3D View Manipulation" on page 29.

2. From the Main menu bar, click on the File > Print
Preview option to display a preview image of the active
view in the Roland Face Designer window.

3. You can use the buttons in the toolbar at the top of the
Roland Face Designer window to view the preview
image in more detail:

• To show the next page of the preview image, click
on the Next Page button. If this button is greyed-
out, there are no further pages.

• To show the previous page in the preview image,
click on the Prev Page button. If this button is
greyed-out, there are no further pages.

• To show two pages in the preview image at the same
time, click on the Two Page button. If this button is
greyed-out, then there is only one page in the
preview image.

• To enlarge the size of the preview image, click on
the Zoom In button.

• To reduce the size of the preview image, click on the
Zoom Out button.

4. You are now ready to print the preview image:
• If you want to print the preview image, click on the

Print button.
• If you do not want to print the preview image, click

on the Close button.
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Print Setup
You can control the settings for the printer to which the content of the
active view is sent by Roland Face Designer.
To adjust the printer settings:

1. Make sure that the window that you want to print is visible
and its content is set, as you want it to appear in the printed
image. For details, see "2D View Manipulation" on page 27
and "3D View Manipulation" on page 29.

2. From the Main menu bar, click on the File > Print
Setup… option to display the Print Setup dialog box.

3. Click on the Name list box, followed by the printer option
that you want to use.

4. In the Paper area, click on the Size list box, followed by
the option equal to the paper size on which you are printing.

5. In the Paper area, click on the Source list box, followed
by the tray or paper feed option that you want to use when
printing.

6. Select the orientation that you want to use when printing:
• Click to select the Portrait option if you want to

print the model vertically. Typically, portrait
orientation is used for models that are taller then they
are wide.

• Click to select the Landscape page option if you
want to print the model horizontally. Typically,
landscape orientation is used for models that are
wider than they are tall.

7. In the Options area, click on the print option that you want
to use:

Note: If you are printing the 3D View window, the print options are
greyed-out. In this instance, Roland Face Designer prints to fit the 3D
View window in its current orientation.

• Click to select the Print model to scale option if
you want to print the model according to its
dimensions.
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• Click to select the Stretch to fit page option if you
want to print the model according to the dimensions
of the paper onto which you are printing.

• Click to select the Print current screen view
option if you want to print the model as it currently
appears in the 2D View window.

8. Click on the OK button to print the active view and close
the Print Setup dialog box.

Exporting a Relief to Roland Medal
Editor

You can immediately use a face relief that you have created and
sculpted in Roland Face Designer as part of a new coin or medal
project in Roland Medal Editor, providing that it is already installed
on your computer.
For further information on using Roland Medal Editor, please refer to
its own Installation & Operation Guide.
To export a relief to the Roland Medal Editor:

1. Make sure that the relief in the 3D View window is as you
wish to use it in Roland Medal Editor.

2. Click on the Roland Medal Editor button  in the File
area of the Assistant's Home page to display the Save As
dialog box.

3. Click on the Save in list box, and then browse to the
location on your computer in which you want to save the
relief.

4. Type a name for the relief in the File name box.
5. Click on the Save button to close the dialog box, save the

relief as a bitmap file (*.bmp) and then open this file in
Roland Medal Editor.

Shutting Down Roland Face Designer
To shut down Roland Face Designer:

1. From the Main menu bar, click on the File > Exit option.
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If you click on the Exit option before saving any changes to an open
model, a message box appears warning you that the model has
changed and gives you the option to save it or not.
If you want to save the model:

• Click on the Yes button to open the Save As… dialog
box. For details on using this dialog box, see "Saving a
Model" on page 35.

If you do not want to save the model:
• Click on the No button to close the model without saving its

changes, followed by the Roland Face Designer itself.

Note: You can click on the Cancel button to close the message box
and remain working in Roland Face Designer.
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Working with Vectors

Overview
In Roland Face Designer you can use the drawing tools in the Vector
Editing area of the Assistant's Home page to create your own
vector artwork. These vectors can be freeform shapes, based on
polylines, or simple circles. Vectors are made up of spans and nodes
(points), and their shape can be modified easily. Your vector artwork
can be used to create three-dimensional shapes and text that can be
combined with the face relief produced in the Face Wizard.

Drawing with Polylines
You can create freeform vectors from polylines, which are one or
more linear or bezier curve spans joined together by points (nodes).

Creating a Polyline
When creating a polyline, Roland Face Designer displays on the
Polyline Creation page in the Assistant window. On this page,
you can read the co-ordinates of the current cursor position, the angle
and the length of the span you are creating, the co-ordinates of the last
defined point (node), and the change in position from the last point
(node) in both the X and Y direction.
To create a polyline:
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1. Click on the Create Polyline button  in the Vector
Editing area of the Assistant's Home page to display the
Polyline Creation page.

2. Click once in the model area shown in the 2D View window
to create the start point (node) of the polyline.

3. Drag the mouse away from the point. A dotted line appears
indicating how and where the polyline is to be drawn.

Note: Click and hold down the left button before dragging the mouse
to create a bezier curve span, rather than a linear span. Release the
mouse button to create the point (node) in the polyline.

4. Click at the position where you want to create the next point
(node) in the polyline.

Note: Hold down the Ctrl key on your keyboard during each click of
the mouse to constrain the angle of the linear span drawn between
points (nodes) to 15 degree increments.

5. Right-click to end the polyline and return to the
Assistant's Home page.

Note: You can also end the polyline if you press the Esc key on your
keyboard or click on the Close button on the Polyline Creation
page.

For example, if you click in the right of the model area, drag
downward to the left and then right-click, you can create a basic
polyline that looks something like this:

You can also create a polyline using co-ordinates taken from the 2D
View window:

1. Click on the Create Polyline button  in the Vector
Editing area of the Assistant's Home page to display the
Polyline Creation page.
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2. Click on the position in the model area where you want to
create the start point (node) in the polyline.

3. Define the position of the next point using any of the
following methods:

Note: Move the cursor to the position in the model area where you
want to create the point (node) in the polyline. The X and Y co-
ordinates for the position are shown in the Cursor Position area of
the page.

• Define the X and Y co-ordinates of the next point
(node) in the X and Y boxes.

• Define the angle of the next span in the ° box,
followed by its length in the L box.

• Define the distance from the previous point (node) in
the X and Y axes in the dx and dy boxes.

4. If you want the polyline to be made up of bezier curve spans
joined by smoothed points (nodes), rather than linear spans
joined by points (nodes), click to select the Draw Smooth
Polylines option. For further information, see "Editing
Vector Spans" on page 52 and "Editing Vector Nodes" on
page 58.

5. Click on the Add button to create the point (node) and its
associated span.

6. Repeat these steps until you have finished creating the
polyline, and then click on the Close button to return to the
Assistant's Home page.

Completing the Polyline
To complete the polyline that you have drawn in the model area, but
remain in Polyline Creation mode:

• Press the Space Bar on your keyboard.
To finish creating a polyline and return to the Assistant's Home
page, leaving it as an open vector, you can use any of the following
methods:

• Right-click on your mouse.
• Press the Return key on your keyboard.
• Press the Esc key on your keyboard.
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• Click on the Close button on the Polyline Creation page.

Amending a Polyline
A polyline is made up of spans and points (nodes). Spans can be lines,
arcs or bezier curves. You can change the position of the points
(nodes) and the nature of the spans after the polyline has been created.
For example, a linear span can be changed to an arc or a bezier curve
span.
You change a polyline's overall shape using both the Node Editing and
Vector Editing menu options available in Roland Face Designer.
These menus are displayed when you work in Node Editing mode and
then right-click on either a span or a point (node) in the selected
vector. For details, see "Editing Vector Spans" on page 52 and
"Editing Vector Nodes" on page 58.

Creating Circles
You can create a circular shaped vector.
To create a circle of a specific size:

1. Click on the Create Circles button  in the Vector
Editing area of the Assistant's Home page to display the
Circle Creation page.

2. Define the centre point of the circle using either of the
following methods:

• Define the X and Y co-ordinates of the circle's centre
point in the Circle Centre's X and Y boxes.

• Move the  cursor over the model area and click on
the position you want to set as the circle's centre
point. The X and Y co-ordinates are shown in the
Circle Centre's X and Y boxes.

3. In the Circle Size area, define the size of the circle. You
can either:

• Click to select the Radius radio button, and then
define the circle's radius in the box below; or

• Click to select the Diameter radio button, and then
define the circle's diameter in the box below.
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4. If you want the circle to be made up of four arc spans, rather
than four bezier curve spans, click to select the Create
with Arcs option.

5. Click on the Preview button if you want to draw a preview
image of the circle you are creating in the model area.

6. If you want to draw the circle and remain in Circle Creation
mode, click on the Create button. If you want to draw your
circle and return to the Assistant's Home page, right-click
on your mouse.

To create an approximate sized circle:
1. Move the  cursor over the model area, and then click and

drag to create the size of circle that you want.
2. Release the mouse button to draw a preview image of the

circle you are creating in the model area.
3. If you want to draw the circle and remain in Circle Creation

mode, click on the Create button. If you want to draw your
circle and return to the Assistant's Home page, right-click
on your mouse.

Selecting Vectors
You can select any of the vectors that you have drawn in the model
area.
To select a single vector:

1. Click on the Select Vectors button  in the Vector
Editing area of the Assistant's Home page, and then click
on the vector that you want to select.

Note: If the Select Vectors button is shown as  in the Vector
Editing area, you are already in Select Vectors mode.

Note: You can also press the Esc key on your keyboard to enter
Select Vectors mode, or right-click to display the Vector Editing
menu, and then click on the Select Vectors Mode option.
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Note: You can also use the N key on your keyboard to toggle
between the Select Vectors and Node Editing modes. For example,
pressing the N key when in Select Vectors mode takes you into Node
Editing mode. Pressing the N key when in Node Editing mode takes
you into Select Vectors mode.

To select more than one vector:

1. Click on the Select Vectors button  in the Vector
Editing area of the Assistant's Home page, and then click
on the first vector that you want to select.

2. Hold the Shift key down on your keyboard, and then click
on each of the other vectors that you want to select in turn.

Note: You can also click and drag around any number of vectors to
select them. A bounding box surrounds all selected vectors.

Tip: To deselect a vector that you have selected by mistake, hold the
Shift key down on your keyboard and then click on the vector in
question.

All vectors are shown in magenta and surrounded by a bounding box
when selected.

Cutting Vectors
You can cut one or more selected vectors from the model area to the
Roland Face Designer clipboard.
To cut one or more selected vectors:

• Make sure that all of the vectors that you want to cut are
selected. For details, see "Selecting Vectors" on page 49.

• Right-click to display the Vector Editing Menu, and then
click on the Cut option.

If you have mistakenly cut any vectors to the Roland Face Designer
clipboard, you can use any of the following methods immediately
afterwards to restore the vectors to the model area:

• Right-click to display the Vector Editing menu, and then
click on the Paste option;

• Press the Ctrl + Z keys on your keyboard; or
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• Click on the Undo button  in the File area of the
Assistant's Home page.

Copying Vectors
You can copy one or more selected vectors shown in the model area to
the Roland Face Designer clipboard.
To copy one or more selected vectors:

1. Make sure that all of the vectors that you want to copy are
selected. It does not matter if you are working in either
Select Vectors, Node Editing or Transform Vector(s) mode.
For details, see "Selecting Vectors" on page 49.

2. Right-click on the selected vector to display the Vector
Editing menu, and then click on the Copy option. A copy
of each of the selected vectors is placed on the Roland Face
Designer clipboard.

Pasting Vectors
You can paste copies of the vectors currently stored on the Roland
Face Designer clipboard to the model area, overlaying the original
vectors from which the copies on the clipboard were first made.

1. Right-click to display the Vector Editing menu, and then
click on the Paste option.

When two or more vectors are selected, all vectors in the selection that
have an overlaying copy are shown in red.

Deleting Vectors
You can delete one or more selected vectors from the model area at
once.
You can use any of the following methods to delete the selected
vector(s):

• Select the vector(s) that you want to delete, and then press
the Delete key on the keyboard;

• Select the vector(s) that you want to delete, and then press
the Ctrl + X keys on your keyboard; or
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• Select the vector(s) that you want to delete, right-click to
display the Vector Editing menu, and then click on the
Delete option.

Moving Vectors
You can move part or the whole of any selected vector object to
another area of the model area.
To move a vector object to another position in the model area:

1. Select the vector object that you want to move. For details,
see "Selecting Vectors" on page 49.

2. Move the cursor over the bounding box. The cursor changes
from  to .

3. Click and drag the vector object into its new position, and
then release the mouse button.

Editing Vector Spans
Spans within a vector object can be linear, an arc or a bezier curve.
You can change the type of span using the Vector Editing options,
displayed when you right-click on a selected vector object.
The Vector Editing options allow you to:

• Convert a span to a line. For details, see "Converting a Span
to a Line" on page 52.

• Convert a span to a bezier curve. For details, see
"Converting a Span to a Bezier Curve" on page 53.

• Convert a span to an arc. For details, see "Converting a
Span to an Arc" on page 55.

• Insert a point (node) into a span. For details, see "Inserting a
Point" on page 56.

• Remove a span. For details, see "Removing a Span" on page
57.

Converting a Span to a Line
Converting a span to a line allows you to alter the appearance of an arc
or a bezier curve span within a vector object.
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To convert a span to a line:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select a vector containing an arc or bezier curve
span. A bounding box surrounds the vector, within which
you can see the spans, points (nodes) and control points that
make up the selected vector.

3. Position the cursor over the arc or bezier curve span. When
the cursor changes from  to , right-click to display the
Vector Editing menu.

4. Click on the Convert span to a line option to convert the
existing span into a linear span.

Note: Moving the cursor over the arc or bezier curve span and
pressing the L key on your keyboard also converts it to a linear span.

In the following example, you can see that if you are to
convert a bezier curve span to a linear span, its adjoining
control points are removed along with any curvature:
Before…

After…

Converting a Span to a Bezier Curve
Converting a span to a bezier curve allows you to alter the appearance
of a linear or an arc span within a vector.
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Converting a span to a bezier curve places two control points on the
span, both of which can be dragged to add or reduce the curvature
within it.
To convert a span into a bezier curve:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select a vector containing an arc or linear span. A
bounding box surrounds it, within which you can see the
spans, points (nodes) and control points that make up the
selected vector object.

3. Position the cursor over the arc or linear span. When the
cursor changes from  to , right-click to display the
Vector Editing menu.

4. Click on the Convert span to bezier option to convert
the existing span into a bezier curve span.

Note: Moving the cursor over the linear or arc span and pressing the
B key on your keyboard also converts it to a bezier curve.

For example, your span may look something like that shown
below:

Although this span may not look like a curve now, the two
control points in it indicate that it is a bezier curve span.
In our example, by dragging the control points as shown
below, a bezier curve span with a smooth curvature is
produced:
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Converting a Span to an Arc
Converting a span to an arc allows you to alter the appearance of a
linear or bezier curve span within a vector.
Converting a span to an arc places one control point in the middle of
the span. This can be dragged to add or reduce the degree of curvature
in the arc.
To convert a span into an arc:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select a vector containing a bezier curve or linear
span. A bounding box surrounds it, within which you can
see the spans, points (nodes) and control points that make
up the selected vector object.

3. Position the cursor over the bezier curve or linear span.
When the cursor changes from  to , right-click to
display the Vector Editing menu.

4. Click on the Convert span to arc option to convert the
existing span into an arc span.

Note: Moving the cursor over the linear or bezier curve span and
pressing the A key on your keyboard also converts it to an arc.

For example, if you were to convert a linear span to an arc
span you would see that one control point is now positioned
in the centre of the arc. You can drag the control point to
create a curve, as follows:
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Before…

After…

Inserting a Point
You can insert a point (node) in any span. Inserting a point divides a
span into two new spans of the same type as the original.
By inserting a point you add greater flexibility in changing the shape
of the vector object.
To insert a point in a span:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector in which you want to insert a
point. A bounding box surrounds it, within which you can
see the spans, points (nodes) and control points that make
up the selected vector object.

3. Position the cursor over the span into which you want to
insert a point. When the cursor changes from  to , right-
click to display the Vector Editing menu.

4. Click on the Insert a point option to produce a new point
in the span, dividing it into two separate spans.
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Note: Moving the cursor over the span and pressing the I or P key on
your keyboard also inserts a point into it.

For example, a point has been inserted into the bezier curve
span illustrated below. You can see that doing so has
created a second bezier curve span with two adjoining
control points:
Before…

After…

Tip: Adding points to a vector object can be a time consuming
process. Alternatively, you can use the Create Polyline tool to
create more complicated shapes from the beginning. With the Create
Polyline page displayed, each corresponding movement and click of
the mouse creates a new point and connects it to the last with a linear
or bezier curve span. For details, see "Creating a Polyline" on page
45.

Removing a Span
You can remove a linear, bezier curve or an arc span within any
selected vector object in the same way.
To remove a span:

1. Make sure that you are in Node Editing mode  For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector from which you want to remove a
span. A bounding box surrounds it, within which you can
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see the spans, points (nodes) and control points that make
up the selected vector.

3. Position the cursor over the span. When the cursor changes
from  to , right-click to display the Vector Editing
menu.

4. Click on the Remove Span option to remove the selected
span.

Note: Moving the cursor over the span and pressing the R key on
your keyboard also removes it.

For example, a vector with two spans appears as follows:

In our example, if you move the cursor over Span 2 and
then remove it from the vector object, the remaining span is
shown below:

Editing Vector Nodes
You can change the structure and appearance of a vector using the
Node Editing options, which are displayed when you are working in
Node Editing mode and right-click on any point (node) within a
selected vector.
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Working in Node Editing mode allows you to:
• Select points (nodes) and control points. For details, see

"Selecting Points and Control Points" on page 59.
• Move points (nodes) and control points. For details, see

"Moving Points" on page 61.
• Smooth points (nodes). For details, see "Smoothing Points"

on page 61.
• Delete points (nodes). For details, see "Deleting Points" on

page 63.
• Align points (nodes). For details, see "Aligning Points" on

page 65.
To edit the points within a vector, you must work in Node Editing
mode.

Note: If the Node Editing button is shown as  in the Vector
Editing area of the Assistant's Home page, you are already in Node
Editing mode.

Use any of the following methods to enter Node Editing mode:

• Click on the Node Editing button  in the Vector
Editing area of the Assistant's Home page.

• Press the N key on your keyboard.

The Node Editing button changes to  when you are working in
Node Editing mode.

Note: If you click outside of the bounding box that surrounds the
selected vector only once, Roland Face Designer remains in Node
Editing mode. If you click more than once, Roland Face Designer
returns to Select Vectors mode. For details, see "Error! Not a valid
result for table." on page 45.

Selecting Points and Control Points
You can select single or multiple points and/or control points in a
selected vector.
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1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the points and/or
control points that you want to edit. A bounding box
surrounds it, within which you can see the spans, points
(nodes) and control points that make up the selected vector.

3. If you want to select a point (node) or control point:
• Move the cursor over the point or control point that

you want to select. When the  cursor changes to a
 , click to select it. The selected point or control

point turns red.
If you select a point that has adjoining control points,
these are selected along with the point itself. All of
which turn red.

If you want to select more than one point (node) or control
point, you can use any of the following methods:

• Click and drag to form a bounding box around them.
The selected points and/or control points turn red.

• Click to select a point or control point. Hold the Ctrl
key down on your keyboard, and then click on
further points and/or control points to select them.
The selected points and/or control points turn red.

• Click to select a point or control point. Hold the
Shift key down on your keyboard, and then click to
select a second point. Roland Face Designer finds the
shortest distance between these two points, and then
selects all of the other points in between them. The
selected points and/or control points turn red.

Deselecting Points and Control Points
If you want to deselect a point or control point:

• Move the cursor over the point or control point that you
want to deselect. When the  cursor changes to a , hold
the Shift key down on your keyboard and then click on the
point or control point to deselect it.
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Moving Points
You can move one or more points and/or control points to a new
position.
To move a selection of points (nodes) and/or control points:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the points you want to
move. A bounding box surrounds the selected vector, within
which you can see the spans, points (nodes) and control
points that make up the selected vector object.

3. Hold the Shift key down on your keyboard, and then click
to select the points and/or control points that you want to
move. For details, see "Selecting Points and Control Points"
on page 59. The selected points and/or control points turn
red.

4. You can now move the selected points and/or control points
using either of the following methods:

• Move the  cursor over any of the selected point(s)
and then click and drag the point into its new
position.

• Use any of the four arrow keys on your keyboard to
nudge the selected point(s) into its new position.

Smoothing Points
You can smooth any point (node) in a vector other than its Start Point
or the end point in an open vector. For details, see "Selecting Vectors"
on page 49.
In smoothing, the span on either side of a point is converted to a bezier
curve span. Roland Face Designer positions control points next to the
point, allowing you to control the degree of curvature in the whole
vector.
To smooth a single point:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the point you want to
smooth. A bounding box surrounds it, within which you can
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see the spans, points (nodes) and control points that make
up the selected vector. All unsmoothed points are shown in
black.

3. Move the cursor over the point that you want to smooth.
When the  cursor changes to a , right-click to display
the Vector Editing menu.

4. Click to select the Smooth Point option to convert the
spans on either side of the point to bezier curves. The point
turns blue.

Note: Moving the cursor over the point and pressing the S key on
your keyboard also smoothes it.

For example, the point in the middle of the vector shown
below has been smoothed:

If you move one of the control points next to the smoothed
point, the other automatically moves with it. This
simultaneous movement preserves the tangency between the
two bezier curve spans.

To smooth a group of points:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the points you want to
smooth. A bounding box surrounds it, within which you can
see the spans, points (nodes) and control points that make
up the selected vector.

3. Select the points that you want to smooth. For details, see
"Selecting Points and Control Points" on page 59.

4. Right-click on any of the selected points to display the Node
Editing menu.

5. Click on the Smooth Points option to convert the spans
on either side of the selected point(s) to bezier curves.
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Note: Moving the cursor over any of the selected points and pressing
the S key on your keyboard also smoothes them.

To remove the smoothing option from a smoothed point:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the smoothed points
from which you want to remove the smoothing. A bounding
box surrounds it, within which you can see the spans, points
(nodes) and control points that make up the selected vector.

3. Move the cursor over a smoothed point (node). When the 
cursor changes to a , right-click to display the Node
Editing menu. The Smooth Point option is selected.

4. Click on the Smooth Point option to deselect it. The point
(node) turns black.

Note: Moving the cursor over a smoothed point and pressing the S
key on your keyboard also removes its smoothing.

Although the span on either side of the point (node) remains
as a bezier curve span, deselecting the Smooth Point
option causes the control point on either side of the point
(node) to affect its adjoining bezier curve span only, rather
than the whole vector.
In our example, you can see that moving one control point
no longer automatically moves the other:

Deleting Points
You can delete any of the points (nodes) within a vector. Deleting a
point does not change the type of span on either side of the point but it
does reduce your ability to manipulate the shape of the whole vector.
To delete a single point:
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1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the point you want to
delete. A bounding box surrounds it, within which you can
see the spans, points (nodes) and control points that make
up the selected vector.

3. Move the cursor over the point that you want to smooth.
When the  cursor changes to a  , right-click to display
the Vector Editing menu.

4. Click to select the Delete Point option to delete the point
from the vector.

Note: You can also delete a point by moving the cursor over the
point and then pressing the D key on your keyboard.

In the following example, you can see that in deleting the
middle point, the number of control points is reduced and its
shape is changed considerably:
Before…

After…

To delete a group of points:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the points you want to
delete. A bounding box surrounds it, within which you can
see the spans, points (nodes) and control points that make
up the selected vector object.
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3. Select the points that you want to delete. For details, see
"Selecting Points and Control Points" on page 59.

4. Right-click on any of the selected points to display the Node
Editing menu.

5. Click on the Delete Points option to delete the selected
points.

Note: You can also delete the points by moving the cursor over any
of the selected points and then pressing the D key on your keyboard.

Aligning Points
You can align a selection of points (nodes) and/or control points
within a selected vector in either the horizontal (X) or vertical (Y)
axis.
To align a selection of points (nodes) and/or control points:

1. Make sure that you are in Node Editing mode . For
details, see "Editing Vector Nodes" on page 58.

2. Click to select the vector containing the points you want to
align. A bounding box surrounds the selected vector, within
which you can see the spans, points (nodes) and control
points that make up the selected vector.

3. Hold the Shift key down on your keyboard, and then click
to select the points and/or control points you want to align
with that selected last. For details, see "Selecting Points and
Control Points" on page 59. The selected points and/or
control points turn red.

4. Right-click on any of the selected points and/or control
points to display the Node Editing menu.

5. Click on the Align Nodes option, followed by either the in
X or the in Y option, depending on the axis with which you
want to align the points and/or control points. By default,
the point selected first is aligned with the point selected last,
and a single horizontal (X) or vertical (Y) linear span
replaces the intermediate points.

Note: You can also align selected points and/or control points along
the X-axis by pressing the X key on your keyboard, and along the Y-
axis by pressing the Y key on your keyboard.
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Transforming Vectors
To transform a vector shown in the model area, you must work in
Transform Vectors mode.
To transform a vector shown in the model area:

1. Select the vector that you want to transform. For details, see
"Selecting Vectors" on page 49.

2. Use either of the following methods to enter Transform
Vectors mode:

• Click on the Transform Vector(s) button  in
the Vector Editing area of the Assistant's Home
page.

• Press the T key on your keyboard.
• Right-click to display the Vector Editing menu, and

then click on the Transform Vector(s)… option.
• Hold the Ctrl key down on your keyboard, and then

click on the selected vector until transform handles
appear on the bounding box that surrounds it.

Note: If you click outside of the bounding box that surrounds the
selected vector once, Roland Face Designer remains in Transform
Vectors mode. If you click more than once, Roland Face Designer
returns to Select Vectors mode.

When working in Transform Vectors mode, you can
transform the selected vector in the following ways:

• To move the vector, move the cursor over its centre,
one of its spans or its bounding box, and then click
and drag it into position.

Note: Hold down the Ctrl key on your keyboard to keep a copy of
the selected vector in its original position when moving it.

• To adjust the size and shape of the vector, move the
cursor over any of its resizing handles, and then click
and drag.

Note: Hold down the Shift key on your keyboard when scaling to
preserve the ratio between the vector's width and height.



Roland Face Designer Working with Vectors  •  67

Note: Hold down the Alt key on your keyboard when scaling to scale
the selected vector about the centre of it's bounding box.

• To adjust the angle of the vector, click and drag the
rotation handle joined to its centre of gravity.

• To shear the vector vertically, move the cursor over
the control point outside of the bottom edge of the
bounding box, and then click and drag.

• To shear the vector horizontally, move the cursor
over the control point outside of the right edge of the
bounding box, and then click and drag.

Creating Vector Text
Creating vector text in Roland Face Designer is very similar to typing
text in most word processing packages. You can type in glyph (closed
vector) fonts only.
For a demonstration on using this tool, see the "Adding Vector Text"
movie on the Installation CD.
To create vector text:

1. Click on the Create Vector Text button  in the
Vector Editing area of the Assistant's Home page to
display the Text Tool page.

2. Select the formatting for the text using the options on the
Text Tool page. For details on the different options
available, see "Formatting Vector Text" on page 70.

3. Move the  cursor over to the 2D View window and click
where in the model (the white area) you want to create the
vector text. A text box appears in the 2D View window and
the mouse cursor changes to .

4. Type the vector text you want to create. It is useful to
remember the following keystrokes when typing in vector
text:

• Press the Enter key on your keyboard to start a new
line of vector text.

• Press the Backspace key on your keyboard to
delete the last character typed.
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5. Click on the Done button or press the Ctrl + Enter keys on
your keyboard to create the vector text and return to the
Assistant's Home page.
The block of vector text is purple and surrounded by a
bounding box:

Note: You can move the block of vector text if you position the
cursor over it, and then click and drag it into its new position.

Selecting Vector Text
You can select vector text whilst the Text Tool page is displayed
using either of the following methods:

• Click and drag over the character or block of vector text that
you want to select; or

• Hold the Shift key down on your keyboard, and then use
the direction arrow keys ( , ,  and ) to control your
selection.
The selected vector text is highlighted in light-blue whilst
the background is shown in dark-blue:

Note: If you have selected a block of vector text containing more
than one style of font, script and/or size, the relative list boxes on the
page are blank.

Once you have created the vector text, you can select it as
you would any other vector using the method described in
"Selecting Vectors" on page 49.

Editing Vector Text
Text editing refers to making changes in vector text, such as adding
and deleting, or copying and pasting individual characters or blocks of
vector text.
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Using the editing buttons in the Style area, you can cut, copy and
paste a selected character or block of vector text when the Text Tool
page:

• Click on the Cut button  to remove the selected vector
text and place it on the clipboard.

• Click on the Copy button  to create a duplicate of the
selected vector text and place it on the clipboard.

• Click on the Paste button  to place a copy of the vector
text, overlaying any currently selected text.

Note: If you copy a block of vector text that contains multiple fonts,
when you use the Paste button  the vector text is written in the
font currently selected on the Text Tool page.

Note: A selected block of vector text that has already been
transformed, e.g. sheared, appears as a default block whilst the Text
Tool page is displayed. After closing the page, the transform is
restored and any changes that you have made to the text are applied.

You can edit a specific character in a block of vector text, or the entire
block, after it has been created using either of the following methods:

1. Select the block of text that you want to edit by clicking on
it.

2. Choose the method that you want to use to begin editing:
• Press the E key on your keyboard to display the Text

Tool page.

• Click on the Create Vector Text button  in the
Vector Editing area of the Assistant's Home page
to display the Text Tool page.

You can also cut, copy and/or paste a block of vector text after it has
been created in the same way that you would any other vector. For
details, see
You can add or delete characters when the Text Tool page is
displayed in the Assistant window using your keyboard:

• Use the character keys on your keyboard to add characters
to the block of vector text.
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• Press the Backspace key on your keyboard to delete the
last typed character.

Tip: You can use the direction arrow keys ( , ,  and ) on your
keyboard to move to the position in the block of text where you want
to begin editing.

You can delete a selected block of vector text when the Text Tool
page is not displayed in the Assistant window using either of the
following ways:

• Move the cursor over the block of vector text, and then
press the Delete key on your keyboard.

• Right-click on the selected block of vector text to display
the Vector Editing menu, and then click on the Delete
option.

Formatting Vector Text
Text formatting refers to setting the way vector text looks using
different fonts, bold or italic type, indents and alignments.
You can format a character or block of vector text both during and
after its creation using the formatting buttons and the list boxes in the
Style area of the Text Tool page.
You can use the formatting buttons as follows:

• Click on the Toggle Vertical Text Flow button  to
display vector text vertically, rather than horizontally.

When the Toggle Vertical Text Flow button  is
selected, the Kerning options are removed from the Text
Tool page and the alignment buttons are adjusted.

• Click on the Bold button  to make the vector text bold,
or to remove the bold formatting.

• Click on the Italic button  to make the vector text italic,
or to remove the italic formatting.

• Click on the Align Left button  to align the selected
vector text to the left of the text box with a ragged right
edge. This button affects selected vector text of more than
one line.
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Note: If the Toggle Vertical Text Flow button  is selected, the
Align Top button  replaces the Align Left button , allowing
you to align the vector text with the top of the text box with a ragged
bottom edge.

• Click on the Centred button  to place the selected
vector text in the centre of the text box. This button affects
vector text of more than one line.

Note: If the Toggle Vertical Text Flow button  is selected, the
icon for the Centered button  is rotated .

• Click on the Align Right button  to align the selected
vector text to the right of the text box with a ragged left
edge. This button affects selected vector text of more than
one line.

Note: If the Toggle Vertical Text Flow button  is selected, the
Align Bottom button  replaces the Align Right button ,
allowing you to align the vector text with the bottom of the text box
with a ragged top edge.

To change the font you are using:
• Click on the Font list box, and then click on the font

required. In the Font list box, you can see a preview of the
font style before it is selected.

To change the size of the font you are using:
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• Define the font size in the Size box. You can also change
the units of measurement by clicking on any of the three
options in the list box to the right: points, mm, or inches.
You can also use the  or  arrows beside the Size box to
set the font size:

• When points is selected, each click on the  arrow
increases the font size by 3 points by default, while
each click on the  arrow decreases the font size by
3 points.

• When mm is selected, each click on the  arrow
increases the font size by 1 mm by default, while
each click on the  arrow decreases the font size by
1 mm.

• When inches is selected, each click on the  arrow
increases the font size by 0.5  inches by default,
while each click on the  arrow decreases the font
size by 0.5 inches.

To change the script you are using:
• Click on the Script list box, and then on the required script.

Kerning, like regular spacing, applies white space on either side of a
character in a block of vector text. Kerning, however, considers the
shape of the previous character in relation to the character that is being
typed, and adjusts the distance between them so that their fit looks
good.
To adjust the kerning between the characters within a block of vector
text:

1. Choose whether you want to adjust the kerning between two
characters within a block of vector text, or the whole block
of vector text:

• Position the  cursor between the two characters in the
block of vector text between which you want to
adjust the kerning.

• Select the block of vector text to which you want to
apply new kerning settings. For details, see
"Selecting Vector Text" on page 68.

2. If you cannot see the kerning settings on the Text Tool
page, click on the  icon in the Kerning area.
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3. Click on the Mode list box and select how you want to
apply the kerning settings to the vector text:

• If you want Roland Face Designer to automatically
apply the kerning settings to all newly created or
edited vector text, click on the Auto option.

• If you want to manually apply kerning to a selection
of specific characters or words within a block of
vector text, click on the Manual option.

4. Define the amount of kerning that you want to apply to the
vector text. To do so, you can either:

• Define the amount of kerning in the Kerning box;
or

• Click and drag on the % of space slider to adjust
the value in the Kerning box.

5. If you want to apply Roland Face Designer's default kerning
settings to the vector text, click on the Default Kerning
button. This is selected by default.

Wrapping Text Round a Curve
Roland Face Designer allows you to position vector text on or around
any open or closed curved vector.
Before you wrap a block of vector text around a curved vector, you
must draw both the curved vector shape and some vector text.
For a demonstration on using this tool, see the "Adding Vector Text"
movie on the Installation CD.
To wrap vector text around a curved vector:

1. Select the curved vector around which you want to wrap a
block of vector text. For details, see "Selecting Vector Text"
on page 68.

2. Hold down the Shift key on your keyboard, and then click
to select the block of vector text you want to wrap around
the curved vector. A bounding box surrounds the selected
vectors.

3. Click on the Wrap Text Round a Curve button  in
the Position Size Align Vectors area of the Assistant's
Home page.
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In the example shown below, we can see that a block of
vector text and a circle are both selected.

4. Click on the Select button to wrap the vector text around
the curved vector.
In our example, the block of vector text is now wrapped
around the circle, as shown below:

5. If you want to reverse the direction of the curved vector,
click to select the Text on other side option.

6. You can use the Editing Style area to control how the
vector text is positioned on the curved vector:
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• If you want to move the block of text into position on
the curve, click to select the Whole Sentence
option, and then click and drag the block of text.

• If you want to move a specific word into position on
the curve, click to select the Single Words option,
and then click and drag the word.

Note: Alternatively, you can hold down the Ctrl key on your
keyboard, and then click and drag a specific word into place.

• If you want to move a specific character into position
on the curve, click to select the Single Letters
option, and then click and drag the character.

Note: Alternatively, you can hold down the Alt key on your
keyboard, and then click and drag a specific character into place.

7. Click on the OK button to return to the Assistant's Home
page.

Centring Vectors
You can align the centre of a selected vector with the centre of the
model. This makes it easy to position circles exactly around the face
shown in the photographic image within the 2D View window.
To align the centre of a selected vector with the centre of the model:

1. Select the vectors that you want to align with the centre of
the model. For details, see "Selecting Vectors" on page 49.

2. Click on the Centre In Page button  in the Vector
Editing area of the Assistant's Home page to align the
centre of the selected vector with the centre of the model.

Joining Vectors
You can join two separate open vectors together to create a new single
vector shape.
To join together a selection of two open vectors:

1. Hold the Shift key down on your keyboard, and then click
to select the open vectors that you want to join together.
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2. Click on the Join Vectors with a Line button  in the
Vector Editing area of the Assistant's Home page to link
the nearest points in the selected vectors with a linear span.

Before… After…

Closing Vectors
You can close an open vector to create a new closed vector shape.
This is particularly useful when creating a closed vector outline of a
face shown in a photographic image imported into the Face Wizard
tool.
To close an open vector object:

1. Select the open vector that you want to close. For details,
see "Selecting Vectors" on page 49.

2. Use either of the following options to close the vector:
• Click on the Close Vector with a Line button

 to join the start and end points (nodes) in the
selected vector with a linear span.

In the following example, we can see how the end point in
the vector outline of a face has been joined with its start
point by a linear span:
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Before… After…

• Click on the Close Vector - Move End Points

button  to join the end point with the start point
in the selected vector.

In the example shown below, we can see how both the start
and end points in the vector outline of a face have been
moved to meet one another:

Before… After…
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Relief Editing

Overview
In Roland Face Designer you can use the tools in the Relief Editing
area of the Assistant's Home page to develop the relief created by
the Face Wizard. These tools, along with the vector artwork that you
have drawn and the greyscale of the photographic image, can be used
to create three-dimensional text, sculpt features, and add perspective
to areas of the relief.

Interactive Sculpting
You can use the Interactive Sculpting tools available in Roland
Face Designer to add detail to the relief calculated using the Face
Wizard, and to improve its overall appearance.
For a demonstration on using this tool, see the "Increasing Hair
Definition" movie on the Installation CD.
To sculpt the relief:

1. Click on the Sculpting button  in the Relief Editing
area of the Assistant's Home page to display the
Interactive Sculpting page and the relief in the 3D View
window. A greyscale of the photo image in the model area
of the 2D View window is projected onto the surface of the
relief by default.

2. In the Sculpting Tools area, click to select which of the
five tools that you want to use:
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•  If you want to smooth an area of the relief by
blending one area into the next, click on the
Smooth tool icon. This tool is selected by default.

Note: You can also press the number 1 key on your keyboard to
select the Smooth tool.

•  If you want to drag an area of the relief to either
extend or reduce it, click on the Smudge tool icon.

Note: You can also press the number 2 key on your keyboard to
select the Smudge tool.

•  If you want to add material to the relief, click on
the Deposit tool icon.

Note: You can also press the number 3 key on your keyboard to
select the Deposit tool.

•  If you want to remove material from the relief,
click on the Carve tool icon.

Note: You can also press the number 4 key on your keyboard to
select the Carve tool.

•  If you want to undo changes that you have made
to the relief during the present sculpting session,
click on the Eraser tool icon.

Note: You can also press the number 5 key on your keyboard to
select the Eraser tool.

3. To change the number of pixels that make up the width of
the tool, click and drag on the Diameter slider.
The diameter of the tool controls how much material is
deposited or removed from the area of the relief affected by
the selected sculpting tool.
Click and drag to the right to increase the width of the tool.
Click and drag to the left to reduce its width. The image to
the left of the slider changes as you move the slider to
reflect the diameter of the tool.
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4. To change the height of the deposit of the depth of the
removal as a percentage of the tool width, click and drag on
the Strength slider.
Click and drag to the right to increase the height of the
deposit or depth of the removal. Click and drag to the left to
reduce the height of the deposit or depth of the removal. The
image to the left of the slider changes as you move the slider
to reflect the height of the deposit or the depth of the
removal.

Tip: If your mouse has a wheel, you can roll it backwards to reduce
the strength of the selected tool, or forwards to increase its strength.

5. To change the sharpness of the tool tip, click and drag on
the Smoothness slider.

6. If you want to sculpt the relief using a greyscale image of
the relief projected onto its surface:

• First, click to select the Use Colours from 2D
view option in the Shading Colour area. A
greyscale of the photo image currently shown in the
2D View window is projected onto the surface of the
relief shown in the 3D View window. This option is
selected by default.

Warning: You might want to deselect the Use Colours from 2D
view option when sculpting the relief. If a photographic image is
projected onto the relief at all times during a sculpting session, your
results can often be deceptive.

• Click and drag the icon over the colour in or around
the photo image projected onto the relief surface
shown in the 3D View window that you want to use
to define the areas of the relief, in which you do or
do not want to sculpt. The selected colour is
displayed in the Colour Usage area.

• Click to select the option in the Colour Usage area
that you want to use to control how the selected
colour is used:
Ignore – Click on this option if you do not want to
sculpt the areas of the relief that are either beneath or
surrounding the selected colour.
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Sculpt only under colour – Click on this option
if you only want to sculpt the area of the relief
beneath the selected colour.
Sculpt excluding colour – Click on this option if
you only want to sculpt the areas of the relief that
surround the selected colour.

7. If you have selected the Smooth or Smudge tool, click to
select a combination method, from the Relief Combine
Mode or Combine Mode area respectively, to use when
sculpting the relief.

• To use the average smoothing result to
simultaneously raise and lower the area of the relief
beneath the tool cursor, select the Normal option.

• To raise the lowest points in the area of the relief
beneath the tool cursor only, select the Raise Only
option.

If you have selected the Deposit tool, click to select a
combination method from the Relief Combine Mode
area:

• To deposit material onto the area of the relief
beneath the tool cursor, select the Add option.

• To deposit a single layer of material onto the area of
the relief beneath the tool cursor, irrespective of how
many passes you make over the area, select the
Merge option.

If you have selected the Carve tool, click to select a
combination method from the Relief Combine Mode
area:

• To carve material from the area of the relief beneath
the tool cursor, select the Add option.

• To carve a single layer of material from the area of
the relief beneath the tool cursor, irrespective of how
many passes you make over the area, select the
Merge option.

8. Click and drag the tool cursor over the surface of the relief
shown in the 3D View window to sculpt the relief according
to the options you have selected on the page.



Roland Face Designer Relief Editing  •  83

9. Click on the Apply button to confirm the changes that you
have made to the relief.
If you want to undo the changes that you have made and
return the relief to its original state, or as it were prior to the
last time you clicked on the Apply button during this
sculpting session, click on the Revert button.
If you do not want to keep any of the changes that you have
made to the relief during this sculpting session, click on the
Cancel button.

10. Click on the Finish button to return to the Assistant's
Home page.

Creating an Angled Plane
You can create an angled-plane in the relief using up to three defined
points in the model area. An angled-plane allows you to add
perspective to your relief and accentuate specific facial features such
as ears, as well as objects such as glasses or a monocle that may be
worn by the person in the photographic image from which the relief
has been calculated.
For a demonstration on using this tool, see the "Fixing Ears" and
"Adding Glasses" movies on the Installation CD.
To create an angled-plane:

1. Click on the Create Angled Plane button  in the
Relief Editing area of the Assistant's Home page to
display the Create Angled Plane page.

2. If you want to create an angled plane within the boundary of
a vector, click to select the vector that you want to use. For
details, see "Selecting Vectors" on page 49. If you do not
select a vector, the angled plane is created across the entire
relief surface.

3. If you want to create an angled plane using three defined
points, click to select the Set Third Point option. The
Third Point on Plane area appears on the page.
The advantage of selecting a third point is that it adds a tilt
or 'roll' to the sides of the angled plane.

4. You can use the mouse cursor to define the points on the
plane:
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• Click on the Start button in the Use Cursor to
Select Points area, move the cursor over the
required position in the 2D View window, and then
click. The co-ordinates for this point are displayed in
the X, Y and Z boxes.
The co-ordinates for this point appear in red when
you click on the Start button, then change to black
when you click in the 2D View window.

Alternatively, type the co-ordinates of the point in the X, Y
and Z boxes in the First Point on Plane area.

5. If you had defined the first point using the mouse cursor:
• Move the cursor over the required position in the 2D

View window, and then click to define the second
point. The co-ordinates for this point are displayed in
the X, Y and Z boxes.
The co-ordinates for this point appear in red, then
change to black when you click in the 2D View
window.

Otherwise, type the co-ordinates of the point in the X, Y and
Z boxes in the Second Point on Plane area.

6. If you had defined the first and second points using the
mouse cursor:

• Move the cursor over the required position in the 2D
View window, and then click to define the third
point. The co-ordinates for this point are displayed in
the X, Y and Z boxes.
The co-ordinates for this point appear in red, then
change to black when you click in the 2D View
window.

Alternatively, type the co-ordinates of the point in the X, Y
and Z boxes in the Third Point on Plane area.

7. In the Combine area, click on one of the radio buttons to
select how the angled plane is combined with the existing
relief:

• To add the angled plane to the existing relief, click
on the Add option.

• To subtract the angled plane from the existing relief,
click on the Subtract option.
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• To merge the angled plane with the existing relief, so
that only the highest points of the two remain, click
on the Highest option.

• To merge the angled plane with the existing relief, so
that only the lowest points of the two remain, click
on the Lowest option.

8. Click on the Create button.
9. Click on the Close button to return to the Assistant's

Home page.

Creating 3D Lettering
You can combine three-dimensional lettering with the relief using any
block of vector text.
For a demonstration on using this tool, see the "Adding Vector Text"
movie on the Installation CD.
To create 3D lettering:

1. Select the vector text from which you want to create the 3D
lettering. For details, see "Selecting Vectors" on page 49.

2. Click on the 3D Letters button  in the Relief Editing
area of the Assistant's Home Page to create the 3D
lettering and combine it with the existing relief.
A progress bar appears beneath the 2D View window
indicating the progress Roland Face Designer is making in
calculating the 3D lettering.

3. Click on the 3D View button  in the 2D View toolbar to
display the 3D View window, in which you can now see the
lettering combined with the relief.
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Before… After…




